How to create window
graphics with the HP
Latex 700 and HP Latex
800 Printer Series
This document will explain how to print on clear
substrates—either self-adhesive vinyl or polyester
films—to create window graphics.
A deep-dive training about window graphics on the
HP Latex 700/800 Printer series is available in the
Learn App from your PrintOS account. See more
details in this article.
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How to create window graphics

What you will need
What you will need

Before
printing

Clear self-adhesive vinyl
or polyester film

SW tools
(RIP, editor, etc.)

Printer

Cutting device HP Latex Cutter Plus

Film laminate (optional)

Film laminator (optional)

Weeding tool (optional)

Transfer tape (optional)

Plastic squeegee with
low-friction sleeve

Preparing the substrate

Preparing the job

Printing

After
printing

The printing process

Post-print finishing
Installation
Water or installation
fluid (optional)
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How to create window graphics

Preparing the substrate
What you will need

1. Types of clear self-adhesive films
By raw material

By surface finish

• Calendered monomeric

• Transparent gloss

• Calendered polymeric

• Transparent matte

• Cast vinyl

• Frosted

• PVC-free substrates

By adhesive type (clear for window
graphics)
•

Permanent

•

Removable

•

Cling (adhesive free)

• Polyester films (PET)*

Before
printing

IMPORTANT NOTE: Clear PET’s are generally available with 2 types of coating: a) for UV inks and b) for Solvent inks. Latex inks
are mainly compatible with PET’s with coatings for Solvent inks. We cannot guarantee full compatibility with PET’s for UV inks,
especially when they’re applied following the wet technique.

Preparing the substrate

2. Usage
• Normally, Clear Vinyl provides an economical solution while Clear PET has a higher transparency.
• For mid- and long-term uses or high-transit areas, it is recommended to protect the graphics with film lamination.

Preparing the job

3. Substrate presets
•

Printing

After
printing

The printing process

Post-print finishing
Installation
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•

Check that the material you are going to use has its own substrate preset:
a)

On the web, in the HP PrintOS Media Locator: www.printos.com/ml/#/medialocator

b)

On the printer’s front panel online search (Substrate Library)

c)

On the web, from the substrate vendor’s or RIP vendor’s websites

Download and install.

NOTE: If you cannot find the substrate presets, you can always use
the generic presets for transparent self-adhesive vinyls or
transparent polyester films already installed in your printer. If you
need to fine-tune some settings, clone the existing generic preset
and modify it, or create a new one with the Add new substrate
function on the front panel.

TIP: Learn how to customize your profile by enrolling on
the available training: “HP Latex 700/800 Printer series –
Advanced main tasks and maintenance routines” on the
Learn with HP website.
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Preparing the job

1. Measure the window
Measure the size of the window and adjust the graphic to
that size. If covering a window from edge to edge, leave a
2-3 cm excess margin on each edge.

What you will need

2. Big windows
Before
printing

Preparing the substrate

Preparing the job

Printing

After
printing

When more than 1 piece of film is needed, adjust the
image to allow 2-3 cm overlap between the different tiles
that compose the whole image.

3. Sign-installation side

The printing process

A. If sign installation is done indoors and the
sign is viewed from outdoors, the image
needs to be mirrored and the white print
mode selection should be overflood or spot.

Post-print finishing

B. If installation and viewing side are outdoors,
the image does not need to be mirrored and
the white printmode selection should be
underflood or spot.

Installation

C. In both situations (A or B), if the image has to
be viewed from both sides, then the white
printmode to use is sandwich mode.
TIP: Play with different amounts of white ink density to modify the opacity of the white layer and its light diffusion capability.
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Preparing the job

1. Software for designing and editing
Tools such as HP Applications Center (HP Signage Suite apps), Adobe Illustrator,
Photoshop, and InDesign help you design and edit jobs and adapt them to your needs.

Make your decision
based on your
needs

A. HP Signage Suite
HP Signage Suite is part of HP Applications Center, a complete package of tools to boost your business

What you will need

Before
printing

Preparing the substrate

How does it work?
1

2

3

Join the platform
Simple, easy sign-in
with your HP printer
serial number.

Choose a web app
Select the standalone decorative
web apps you want to produce
with and allow your customers
to create and visualize the
design with a simulation for
each unique environment.

Manage orders
Manage production
efficiently with automatic,
reliable, print-ready PDF
generation, as well as
customer, order, and
content management tools.

Preparing the job

EXPAND YOUR KNOWLEDGE: For further detailed information regarding HP Applications Center and how to log in for the first
time, check out the webinar available at this link!

Printing

The printing process

2. Create White ink layers
You can use several tools to create the white ink layer in your image:

After
printing

Post-print finishing
Installation
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1. Using Adobe - it permits you to allocate the white ink on all the desired places of your image.
2. Using the RIP - it is a more simple and easy way but offers fewer design options.
NOTE: To work with white ink layers, learn how to create one with Illustrator and Photoshop by enrolling in the available training:
“HP Latex 700/800 Printer series - White ink” on the Learn with HP website, or also refer to the cookbook How to print on white.
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Preparing the job

3. Add contour cut paths for automatic cutting
A. Using Adobe Illustrator
•
•
•
•

What you will need

Before
printing

Make your decision
based on your
needs

Create a new color swatch
Assign an identifiable name, e.g. CutContourKiss
Select color type: Spot Color
Create the cutting path with that color swatch

Preparing the substrate

B. Using SAi HP Flexi Print and Cut Editor

TIP: To avoid cutting inaccuracies,
add bleed to the contour line where
the cutting path goes, so the cut
will not fall in undesired areas

Preparing the job

Printing

After
printing

The printing process

Post-print finishing
Installation
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1. Select the path
It will be highlighted in the Design
Editor window

2. Add the Contour Cut
From the Effects tab in
the menu bar

3. Specify Contour properties
From the Design Central window.
Select the color and click Apply
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Preparing the job

4. RIP processes
ONYX, Caldera, and SAi RIPs have been certified for HP Latex 700/800 series printers.
All these RIPs have specific options for job editing.

Make your decision
based on your
needs

A. Substrate & Printmode selection
What you will need

• Choose the substrate type (Generic Transparent Self-adhesive Viny or
Generic Transparent Polyester Film), then select the specific substrate
you have loaded on the printer.
• Next, choose the printmode. There are several printmodes that are
available to choose from based on how the white ink is placed.

Before
printing

Preparing the substrate

NOTE: Before selecting the substrate in the RIP, it must be loaded on the printer

Preparing the job

Printing

After
printing

The printing process

Post-print finishing
Installation
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Underflood Mode
Select this mode on
substrates installed and
viewed from the same side
(generally outdoors). In
this mode, a white ink
layer is printed first and
then a color layer is
printed on top of it.

Overflood Mode
Select
this
mode
on
substrates applied on one
side and viewed from the
other side (generally applied
indoors and viewed from
outdoors). In these modes a
color layer is printed first and
then a white layer is applied
on top.

• You can also choose the white ink
levels depending on the desired speed,
opacity and available printmodes

Spot Mode
Select this mode to print
images where white is not
mixed with other colors in
the same area and/or
printed with only white.

W60
W100
W160

Sandwich Mode
There are 2 Sandwich modes
to choose from depending on
the
application’s
need:
Sandwich 3 Layers (also
known as 3L) for day and
night
applications,
and
Sandwich 5 Layers (also
known as 5L) for dual-sided
applications

NOTE: More information on
how to print with Sandwich
mode here: How to Print
Sandwich Mode
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Preparing the job

B. The Choke functionality
Make your decision
based on your
needs

Choke is used to shrink the white layer if there is a misalignment between the color
layer and the white layer in the printed output, such as in the examples below.

• By default, the RIP applies a
default value of 3 pixels for
choke.

What you will need

• If a different value is required, you
can modify the value in the RIP.

Before
printing

Preparing the substrate

Preparing the job

ONYX
In the job queue:
1. Right-click on your job.

Printing

The printing process

2. Select Edit > Printer
Settings.

2

3. Check White choke control.

After
printing

Post-print finishing

4. Adjust the number of pixels
you want to reduce.

3

4

Installation
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Make your decision
based on your
needs

Preparing the job
Caldera
3

What you will need

2. Click on Specific settings for printer
(wrench icon).
2

Before
printing

1. Open your printer options menu.

Preparing the substrate

3. Under the Advanced parameters menu,
select Smart Chokes and adjust the pixel
amount that needs to be reduced.

1

Preparing the job

SAi
Printing

The printing process

In the job properties menu:
1. Click the Printer Options tab.

After
printing

Post-print finishing

2

2. Select Smart Chokes and adjust the pixel
amount to be reduced.

Installation
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C. Option to optimize lamination
Make your decision
based on your
needs

Preparing the job

ONYX
In the job queue:
1. Right-click on your job.

What you will need

2. Select Edit > Printer Settings.
3. Click Optimize for lamination.
3

Before
printing

Preparing the substrate

Caldera
3

1. Open your printer options menu.

Preparing the job

2. Click on Specific settings for printer (wrench icon).
3. Under the Advanced parameters menu, select
Optimized for lamination.

Printing

The printing process
1

After
printing

SAi

Post-print finishing

In the job properties menu:
1. Click the Printer Options tab.

Installation
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2

2

2. Select Optimize for lamination.

© Copyright 2021 HP Development Company, L.P. The information contained herein is subject to change without notice.

How to create window graphics

Preparing the job

4. Tips for Print&Cut jobs with white ink on special substrates - SAi
Some specific settings are required to work with substrates such as:

What you will need
Color substrates

Before
printing

Preparing the substrate

•

Preparing the job

Printing

After
printing

The printing process

Post-print finishing

A

C

Select a white printmode:
UF, SP, OF or SW of W100 density

B. Color separation
• Select the Channel Spot1
• Edit
• Select Print as White

B

D

C. HP barcode
• Select the OPOS desired and HP
barcode
• Select Add white background

D. HP barcode
Installation
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A. Select printmodes

Transparent substrates
with transparent liners

Metallized substrates

• OPOS and HP barcode are printed
with white borders so they can be
read by the OPOS sensor
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The printing process
What you will need

Loading substrate | Connecting to the take-up reel (TUR)
1.

Prepare the TUR
Attach an empty core on the TUR.

2.

Move substrate
Advance the substrate until the leading
edge levels with the TUR.

1

2

Release substrate from pinches

Before
printing

Preparing the substrate

Preparing the job

Printing

After
printing

4.

Lift the pinchweels.

•

Align the right edge of the substrate
with the right edge of the input roll.

•

Tap Done in the front panel to lower
the pinchwheels.

Attach substrate to the TUR (optional)
You can attach the substrate so that the
printed side is in (a) or out (b) (out is the
most common).

3

5

a)

b)

4

6

The printing process

Post-print finishing
Installation
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3. •

5.

Activate the TUR
Complete a full rotation of the TUR.

6.

Calibrate the TUR
Select Calibrate on the front panel.

TIP: For long jobs, connect the substrate to the take-up-reel (TUR). For tiling applications, connect the TUR before starting to print.
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NOTE: Perform the printhead nozzle check and printhead alignment on white self-adhesive vinyl before loading a
transparent film with transparent liner.

The printing process

Load the substrate roll

What you will need

1. By default, this is in automatic mode.

1

2

3

3

4

4

5

6

NOTE: In cases where you are loading very
thin films, you might need to load them
manually with the help of the loading accessory.

Select the right substrate preset

2. If your substrate is new, select the type
(Generic Transparent Self-adhesive vinyl or
Generic Transparent Polyester Film).

Before
printing

Preparing the substrate

3. •

Color calibration is not supported for
transparent substrates.
• Perform advance calibrations.

Preparing the job

Printing

Calibrations

The printing process

Loading Position

4. Normally, transparent films can be printed from
the pinches, but some films may need to be
positioned after the curing zone or even be
attached to the TUR to avoid a substrate crash.
For Transparent vinyls, the TUR is recommended.

Send the job to print from the RIP

After
printing

Post-print finishing

5. •

Click Send to print.

Cut & retrieve the printed roll

Installation

6. This can be done in automatic mode or manually.
TIP: Before cutting the printed job, advance the substrate so that you protect the printed roll when it is unloaded.
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Post-print finishing

1. Lamination (optional)
Use the film laminate recommended by the film manufacturer.
Follow the lamination settings (speed, pressure, and temperature) specific for the SAV+laminate combination.

What you will need

IMPORTANT!: Recommended for long-term usage, high-transit
areas, and surfaces that will be cleaned frequently.

TIP: Remember to select a printmode with NO overcoat when you

Before
printing

are going to be laminating your job later, or check the option
“Optimize for lamination” in the RIP’s printer settings.

Preparing the substrate

2.Cut
To cut the graphics automatically, you can use XY cutters or flatbed contour cutters.

Preparing the job

Printing

After
printing

The “Kiss cut” cutting type will be the most common, but on some occasions, a “cut through” can be added to separate
each sticker.

The printing process

Post-print finishing
Installation
New HP Latex Cutter Plus

14

Weeding after a kiss cut

Sticker with cut through
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Post-print finishing

3. Cutting special medias – white ink OPOS
A. Load the plot correctly

Position the plot so that the first pinch
partly rolls over the white part of the HP
barcode (see picture).

What you will need

Before
printing

Preparing the substrate

Preparing the job

Printing

After
printing

Print calibration boxes (3x3 cm) in black
(100 CMYK) and white (Spot W100) on
the substrate for your print&cut jobs.

IMPORTANT!: The
unattended workflow will
not work with the HP
barcode with a white
background. After the first
job is cut, you will have to
position the OPOS sensor
just below the HP barcode
of the next job.

The printing process

Post-print finishing
Installation
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B. Calibrate media (OPOS)

On the cutter’s front panel, tap:
Calibrations > Calibrate media (OPOS).
Follow the front panel instructions; you
will be asked to position the OPOS
sensor above each color patch, including
the non-printed area.

TIP: Perform all the
necessary calibrations on
your cutter before
continuing with your
print&cut job. For further
information, check the HP
Cutter user guide.
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Installation

1. Handling Samples
• Handle samples with care! It is recommended to use gloves to
prevent leaving fingerprints on the surface. We recommend rolling
the printed samples on the outside of an empty core to prevent
leaving accidental folding marks.
• Follow media vendor instructions to protect and store rolls.

What you will need

Before
printing

2. Pre-Cut samples
• In case of wrapping windows from edge to edge, pre-cut samples
leaving 2-3 cm margins on the edges close to the window frame.

Preparing the substrate

• In case of contour cuts, cut the samples to its final dimensions,
leaving 2-3 cm margins on the edges close to the window frame.

Preparing the job

3. Clean the window
• Dust particles present on the glass will cause a visible bubble in the film.

Printing

The printing process

• Clean the window using a specific window cleaner or soapy water. Use a window scraper to remove adhered dust
if needed. Remove the water using a rubber squeegee and a lint-free cloth.
• Pay extra attention to the dirt present on the window glass edges and frame.

After
printing

Post-print finishing
Installation
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Installation
What you will need

Before
printing

Preparing the substrate

Preparing the job

Printing

After
printing

17

The printing process

4. Registering the sign’s position
a. Place the sign on the window, without
removing the liner yet, and with the
help of a bubble level, place the sign in
its final position.

a

b

c

d

b. Apply 2 pieces of tape to fix the sign in
its position.
c. Carefully cut the tape on the edge of
the sign with a sharp cutter. Do not
apply pressure in order to not scratch
the glass. The tape left on the window
will be used as reference together with
the tape on the sign.
d. Align the 2 pieces of tape to ensure
proper registering and apply the sign.

5. Remove the liner
a. Remove the film’s liner on a clean surface. When removing the liner from
the printed film, static charges may be created and some dust may adhere
to the adhesive. In order to prevent the dust from adhering, spray soapy
water on the exposed adhesive while the liner is being removed.

Post-print finishing

NOTE: If sign is applied using the wet technique, ensure that you use a
substrate with a solvent adhesive. Water-based adhesives may leave a milky
finish when they come in touch with water.

Installation

TIP: To remove the liner easily you can use 2 pieces of tape adhered on
both sides of the sign. Place those pieces on a corner and pull them away
from the sign.
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Installation
What you will need

Before
printing

6. Apply the sign
a. Spray water on the center of the
window, trying not to wet the window’s
edges.
b. Place the sign in its final position using
the registers previously marked. In case
the film is adhering to the window,
spray some more water on the window.
c. With the help of a soft squeegee,
remove the water, moving the
squeegee from the center to the edges
of the sign.

Preparing the substrate
TIP: For lettering jobs, use transfer tape for
perfect placement of each piece.

Preparing the job

7. Cut to final size
With the help of a 5-way tool or with a long squeegee, press the excess
of film to the edge of the window frame.

Printing

The printing process

Place the 5-way tool or the long squeegee between the cutter and the
window edge. Use the 5-way tool as a guide to cut the excess of film.
NOTE: Following this step, the film won’t touch the edge of the window, and
this space will become almost unnoticeable.

After
printing

Post-print finishing
Installation
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8. Re-squeegee the sign

Installation

Spray some soapy water on the installed sign and re-squeegee it
until removing the excess of water that might remain between
the window and the sign.

What you will need

9. Cleaning
Before
printing

Preparing the substrate
During the life of the sign, it will probably be needed to clean the
window and the sign. We recommend cleaning it with soapy water and
a soft cloth. We do not recommend use aggressive, alcohol-based
cleaners to clean the sign.

Preparing the job

Printing

After
printing

The printing process

Post-print finishing

10. Signs with multiple panels
In case of using multiple panels, follow the same steps. Allow 2-3 cm
overlap between the different tiles that compose the image.

Installation
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Remarks
•

High opacity true white, without yellowing over time.

•

High flexibility white with strong scratch resistance.

Learn more at:

•

Automatic white maintenance & low waste solution.

•

The new HP Latex inks are ideal for safe indoor applications. The newest HP Latex Inks are UL ECOLOGO and UL GREENGUARD
GOLD certified, and conform to the Zero Discharge of Hazard Chemicals (ZDHC) manufacturing restricted substances list v1.1.

• HP Latex Knowledge Center

•

We recommend protecting your prints with film lamination for long-term usage and high-transit areas.

• Learn with HP

1
Zero Discharge of Hazardous Chemicals. Applicable to HP Latex Inks. The ZDHC Roadmap to Zero Level 1 demonstrates that an ink conforms to or meets the standards of the ZDHC Manufacturing
Restricted Substances List (ZDHC MRSL) 1.1, a list of chemical substances banned from intentional use during production. ZDHC is an organization dedicated to eliminating hazardous chemicals and
implementing sustainable chemicals in the leather, textile, and synthetics sectors. The Roadmap to Zero Program is a multi-stakeholder organization which includes brands, value chain affiliates,
and associates, that work collaboratively to implement responsible chemical management practices. See roadmaptozero.com.

Certifications:

2

Level 1- Zero Discharge of
Hazardous Chemicals (ZDHC)1

Applicable to R Series and 700/800 Printer series HP Latex Inks. UL ECOLOGO® Certification to UL 2801 demonstrates that an ink meets a range of multi-attribute, lifecycle-based stringent criteria
related to human health and environmental considerations (see ul.com/EL). HP is the only printing company with UL ECOLOGO® Certified inks in the “Printing Inks and Graphics Film” product
category, see spot.ul.com/main-app/products/catalog/.

Inks meet stringent
health and
environmental criteria2

Unrestricted, full room.
No-wait installation or
lamination3

3

Applicable to HP Latex Inks. UL GREENGUARD Gold Certification to UL 2818 demonstrates that products are certified to UL’s GREENGUARD standards for low chemical emissions into indoor air
during product usage. Unrestricted room size—full decorated room, 33.4 m2 (360 ft2) in an office environment, 94.6 m2(1,018 ft2) in a classroom environment. For more information, visit ul.com/gg
or greenguard.org.

In partnership with:
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